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Introduction

This User Guide describes the procedures involved in establishing and maintaining proposals in
the Trnseport Proposal and Estimates System (PES) for contracted work.

This User Guide complements the Reference Manual for Production Projects, and is reduced in
scope to be a quick reference of steps in creating proposals for construction contracts.

Appendix A shows the structure of Access Control Group.

Creating a Proposal

To begin the process you do not have to initially define all proposal details, just the Proposal
Header information. Tell Trnseport which projects are to be assigned to it, and Trnseport will
create the proposal details. After you create the proposal, assign it to a bid letting and produce
the appropriate proposal and letting documents.

Lump Sum Contracts

For projects that are to be let as Lump Sum contracts, duplicate projects and proposals will be
created to track project and proposal detail. These tracking projects will be set up one for one for
the proposal and all projects attached to it. Tracking Projects will be identified by a thirteen
character ID. The first eleven will be the regular Financial Project Number plus the two
characters LS. These tracking projects will be fully defined with pay items, quantities, prices
and all other details of a regularly let project.

The Tracking Proposal IDs will be seven characters in length. The first five will be the regular
Contact ID plus the characters LS. A representative contract number would be T3052LS or
E2G53LS. After the regular projects and proposals are created and synchronized with the
Financial Management System (FM), the tracking projects and their proposal header may be
created with the copy special feature.

No other duplicate projects or proposals are to be added to the production environment of
Trnseport, as they will produce quantity errors in some of the reports

Working with Proposals

E3A40 BRIDGE PAINTING cD
E3a41 SR 189 BEAL PARKWAT (RESURFACING) cD

H E3Aaaz BRIDGE PAINTING , BRIDGE MNO. 500082 cD

o define a Proposal Header, open the el R M AN o5

1 E3Aaa PUSHBUTTOMN COMNTRACT cD

. . E3ma5 PUSHBUTTOMN CONTRACT cp

PrOpOSaIS LISt WIndOW E3A45-R1 PUSHBUTTOMN CONTRACT cD
y E3A48 PUSHBUTTOMN CONTRACT cp

E3a47 BRIDGE REPAIR J REHABILITATION cp

" E3Aas SR 10 (US 90-4)(3 MILE ROAD) WEIGH STATIOMN AT ALA S CD

H H £ E3A49 BRIDGE- REPAIR | REHABILITATION <D

° Ick the roposal icon. | li= o Ao Bt o0 BRI O BRIDOE NG, 460073 (REHAT)  ob

E3R52 CR 399 MavaRRE BRIDGE , BRIDGE 580851 REHJ/REFAI CD

E3a58 REPAIRIREPLACE STORM-SIDE-CROSS DRAINS wo

E3A57 PUSHBUTTON THERMOPLASTIC W

E3ase PAINT, THERMOPLASTIC, & RPMs ESCAMBIA & SANTA RO MC

E3a53 ROADIARY LANDSCAPING (QUINGY) oD

E3a80 THERMOPLASTIC J STRIPING ON VARIOUS RiVs 55,56,50 CD

E3A81 PERMANENT THERMOPLASTIC STRIPING cp

E3AB2 PERMANEMNT THERMOPLASTIC STRIPING BAY, GULF & C:  CD

£3A63 PERMANENT THERMOPLASTIC STRIPING, OKALOOSA &% CD

A C ange Or e ete proposa recor S E3AB4 PERMANENT THERMOPLASTIC STRIPING co
1 1 E3ABT Flashing Beacan Assembly cD

. - - E3a88 THERMOPLASTIC STRIPING OM VARIOUS Riws 61,53 &£ OD

from thls IISt Wlndow E3A70 PLACEMENT OF PERMANENT THERMOPLASTIC STRIPINC CD
. E3A71 SR 292 BARAMGCAS AVE. OLD BAYOU CHICO BRIDGE MO. CD

E3a72 MOWING AND LITTER REMOWAL ONM WARIOUS RAVYS 48, 4 MC
E3A73 COMNST. M. BOUND RT. TURN LANE MILL RESUR. DRAINA  CD
E3AT4 MOWING OMLY IN OKALOOSA CO Mc
E3ATS MOWING ORLY (-10) OKALOOSA & WALTON COs Mo
E3ATE MOWING OMNLY PRIMARY RANS IN HOLMES & WWaASH ©Os. MO
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The Proposal Header
To create a new proposal,
e Rclick Tabbed Folder Add.

Trnseport displays the first page of the
General tab.

The General Tab

General Tab page 1

Begin by entering the lead Project
Number in the Cntl PCN field. This will
save the necessity of re-entering other
information.

e Click Cntl PCN.

e Click the appropriate Financial
Project Number, from the list box.

e From the Menu Bar, Click Edit >
Import Controlling PCN Data.

If there are several projects to be strung to
the Proposal Header, import this data for

the lead project and alter fields in the Proposal Header as

necessary to reflect the combined work.

The warning screen tells which fields will be filled with

imported data.

e Click YEs.

e Enter as much information as possible for the
remainder of page 1. Be sure to enter the

following required fields.

pr Trns-port PES

File Edit Wiew Utiities Window Help
ixBaE || e | ¢t 2o AveEE6E

fr; Proposals

E2E31-R1 MAINTEMANCE OF TRAFFIC - SURVEY M
E2E32 D THERMOPLASTIC M
E2E33 B8R AA/ST.JOHMS RIVER ch
E2E34 -95/S0 HAMPTON AND cD

E2E35 Us 3018k 200 cD

E2E37 BR10/US 80 &ad

E2E38 SR13ISAN JOSE BLYD %:rt'ga

EZE4n ugan

EZEN SR hd:
E7E42 SR 16 /3HANDS BRIDGE a Jer Change
E2E43 sR20 Tabbed Foider Vs
EZE44 EMERGENCY FENDER REPAIR S —
E2E45 SR 100 Proposal

EZE46 HOGTOWN CREEK Proposal Project List
E2E47 TREE AND BRUSH REMOVAL ON THE INT -roposal Descrption
EZE48 HIGHIAAY LIGHTING S‘f:ii'ﬂ“ti;
E2E48 CONCRETE DITCH REPAIR oeall

E2E52 SR 56 (US19) ;E:i'zz&?i'zm
E2E53 sR 207 sl

EZES4 SR Z6/NEWBERRY RD S

E2ESS Maintenance of Traffic LR
E2E57 SR 47 B Frocsss...
E2E50 SR11SSOUTHSIDE BLYD

i Gdr e Umioes Wedos e

i80S 09 L HE t
Goowrdd | pescigaon | gtes | Projuces | Specis Provaions | secoes | mems | P schwouie | Asaceeness |
& pagn ] paan 2
Contract Lathrg Mo, .
Ronwatie =] specvearfia Frev Lat & Cont 07
Destription
Fodretale Project Mo cntl PN
Location
Foouts Number. fuppl Soocvear[
Fiaad Systens Fregsal Type:
Hghway Trpe: Bid Mrinod
g Numear Contraet Typs
Primary Digtrict + Conlract Work Tyoe.
Coro Groun et Aukse Broposal
Counties DBEMEE Goal (PEToR 00
Wi Oosl Ty 00
Proposil Class) Frog OBE Coals
Juaincaton Classes

Projucts | SpecatProvaions | Secwees | meme | Fr Scheduie | atachenen

Contracti0 E 1 Lt No, cul.
Ronewatie [N =] Specvearkia Frevistas contm|
Descriphion
Fudrstato Brojuct Mo fIa
Location
Rous Numbsr[  Suppl Specvear]
Foud Sytem Propotal Type:
Hohway Tepee| BoMrnod|
Fighway NumEar Contract Typs
Prirmary Disieit # Cenlract Werk Trpe
Contol Groug: £t ke Propusal
Counties: DBEMBE Goal FOT 000
WWRE Goal FCTy 00
Pruposal Class Preg DB Qoals
Susificaton Classes
PES - Proposal Tab Folder I

Importing Controlling PCN's data will affect the Following fields:
- Federal{State Project Mumber
- Spec Year
- Description
- Location 1, Location 2
- Counkyl, Counky2, Counky3, Counky4
- Route Mumber
- Road System
- Primary Diskrick

Do you wish to continue?
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Contract ID Enter the planned Contract Number.

District Let Contracts: Enter the planned District Contract number in the

general form E#???, where # is District Number and ??? is a sequence number.
Do not enter dashes or spaces. If a contract is to be renewable, add the suffix —
RO to the contract ID

Central Office Let Contracts: Enter the planned "T" number in the general
form T#?7?7?, where # is District Number and ??? is a sequence number. Do not
enter dashes or spaces.

Renewable Assign the flag Y if suffix —RO is assigned to the Contract Id, otherwise

assign N.
Description Prev Let As ContlD  Federal/State Project Number
Contl PCN Spec Year Proposal Type
Contract Type . Bid Method Primary District
Managing District. Contract Work Type Control Group
Counties Proposal Class** Qual Classes

Contract Type. The code table for this field has been restructured as follows.

Construction Contracts

CC
CCP
CDB
CEC
CFR
CHW
CLS
CPB

Construction Contract

Construction Contr Private Partnership
Construction Design Build Contract
Construction Emergency Contract
Construction Fast Response Contract
Construction Hold Witness Contract
Construction Lump Sum Contract
Construction Push Button Contract

Traffic Operations Contracts

TO
TOPB

Traffic Operations Contract
Traffic Operations Push Button Contract

Maintenance Contracts

MAM
MC
MCS
MEC
MG

Maintenance Asset Management
Maintenance Contract

Maintenance Contractual Svcs Contract
Maintenance Emergency Contract
Maintenance Grant

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2
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MMOA Maintenance Memorandum of Agreement
MPB Maintenance Push Button
MPO Maintenance Purchase Order

* *

* *x
Proposal Classand  Qual Classes.

Run the Work Class Percentage Report to find the values [gm —
for these two fields. Use the highest percentage nerateProposal — =
classification, (other than MOT or Other) for the Proposal | |senerate Section and Line Nurbers dnguiry

Generate Section and Line Mumbers (Update)

CIaSS USG the three hlgheSt (Other than MOT OI’ Other) List Contract Proposals

List Proposal Addendums

for the three Qual Class fields. This step will need to be List Froposal Provisions
performed when the estimate for the proposal is et G L

Work Class Percentage Report

essentially complete.
oK | Cancel | Help |
When page 1 is complete,

e Click the page 2 radio button
located in the upper left corner of | azmaz =& = um -

H :
the General tab. Ganaa | Descipion || sies || Projecs | Speciaiprovsions | sechons. | tams. | FYSchedol | Alachments |

e g page 2

General Tab page 2

BidRond oo
Costof Proposal Package: 08 Sectan Assignment [
:::;;aa?: gg: Speclal Provisions: [
e Continue entering information. i R
Most of these fields have default o
Proposal Hotes, [
values.
Bid Bond (0)
Cost of Proposal Package
Section Assignment Cost of Plans
Cost of Specs Cost of Proposal Acquis. Time
Special Start Date Proposal Notes
w+, Trog-port PLS
The Description Tab RS T T

e Propuosal 130737

The descriptlon for the proposal' It can General  Description | Siies | Projects | Speclal Provisions | Sectons | tems | reodl | Atachments |
appear on proposal-related reportS| SUCh aS THE WORK INCLUDED UNDER THIS CONTRACT CONSISTS OF MILLING
. . . . AL'? I'!ESUI'!FAC_INC-. SAFET\ r’-\ND DPAIMA;._E IMI"I:!C\-"EME r"l"l»ll\l-lt‘-
the notice to bidders. This field should be {REAS OF WIDENING AND LANE ADDTIONS ALNG 7. 353 FROM THE
. . . WVARLILLA, COUNTY LINE TO HANNON WILL ROSD M LEON COUNTY
a general description of the work, where it
is located, and any unusual aspects that

should be made known.

In the Proposal tabbed folder window,

e Click the Description tab.
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Begin entering information on the top row and at the extreme left of the window. Enter a
description of up to approximately 32,000 characters or 400 lines. Do not press <ENTER> at the
end of each line; Trnseport automatically wraps text to a new line. Press <eNTER> only to start a
new paragraph. Use the windows Copy (or cTrL+C) and Paste (or cTRL+Vv) commands from the
Edit menu to copy and paste text from other programs such as word processing.

The Sites Tab
The Site Details window will appear in the lower

File Edit “iew Utiities ‘Window Help

portion of the screen. The first Site number is 1xBeE | FHE | 0| Th | &
ass'gned a‘ defaUIt Value Of OO . Enter Overa” enera\scrimiun Sites | Frojects |SpecwaIPruwsians| Sections I
information regarding the proposal. If additional Fi e Number:

completion dates or mandatory start dates are
required for portions of the proposal, add additional
rows by clicking Abb MorRe. Number these other
Sites from 01 onward.

e For each Site record fill each field as
appropriate.

Site Number Type of Days
Liquidated Damages per Day

4]

-Site Details
N um_b_er Of Days i;feli:g:;; EDD Liquidated Damages per Day: |1—
SpGleled Start Date Mumber of Days: 4353 Maximum DaysA+B)
-pn - Road User Cost Per Day; (entering cost per day indicates (A+H) Site Time co:
Specified Completion Date -
Specified Start Date aoima0mo (2]
DeSCI'IptIOI’] Specified CnmpD\etmﬂ.Dtate . utmuuttgu EI -
escription: | Contract Tirne v
Comment
Enter at least one proposal site record. The s

liquidated damages rate has been set to "1". Do not [ — ‘ _

A . Crstat| | @ ) @ (@ | (& Launchba -Microsol...| € Citix Access Plafor.. | CAUsersiFric
change this value. Liquidated Damages
information will be communicated to bidders as a part of the specification package. Assessed
Liquidated Damages will be handled in SiteManager.

When the Site Information is complete,

e Click ok for the information to be recorded in the data row.

Alternative Contracts

As noted above, the Site Tab information transfers to SiteManager and may be used for a variety
of ends including Contract Time, Daily Rates, Incentives and Disincentives, and administrative
information.

The Site Tab contains a field named Road User Cost Per Day. This field is to remain blank
unless the proposal will be processed under Alternative Contract procedures, in which case it
will be filled as described below. When Road User Cost Per Day contains a value, the particular
Site will be used in the analysis of bids to determine the successful bidder.

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2 Page 8 of 32



For Time Bid contracts there are three items of information to be retained from the
preconstruction work. These are:

+«+ The engineers estimated duration for the Contract Time or Lane Rental period.

R/

+«+ The maximum number of days that bidders may bid for the Contract Time, or for the
Lane Rental period.

o,

% The Road User Cost per Day.

A + B Contracts
File Edit Yiew Utliies ‘window Help
At the General tab, [1x@as ®H | & | v
° Select the appropriate Type in the Bid General | Description Sites | Projects ISpema\Provisionsl Sections | I
- Find Site Number: l—
Method field.

Cantract Time

At the Sites tab enter data in the following
manner.

e Site Number Use the default value of 00.

e Liquidated Damages per Day There is
a default value of $1.00. Do not change
this value. Liquidated Damages will be
managed in SiteManager.

L

e Typeof Days Choose AD in the drop Sito Dol

down menu. This is the default value for e orre Liulasted Darnages e Day
urnber of Days: Masirnurm Days(a+B): 675
Construction Contracts_ Road Us:(jnhstPerDD\;y :;39 ientering cnstperday\lfnmcates (A+B) Site Time cost))
. Specified Start Date: Wﬂ
e Number of Days  Enter the Engineers Sweclec Compllon Date[_TAT0A0 9 -
estimated duration for the contract. Soment ]
e Road User Cost Per Day Enter the =

Cstat| | @ o & @ | (B Lawchbar - Micrasok..| & CitinAccess Plator.. | Csers\FiAD
=

daily rate determined for the contract.

e Maximum Days Enter the maximum number of days that will be indicated in the
Contract Specifications.

e Description  Enter "Contract Time" from the SITEDES code table choices.
e Click ok to save the record to a data row.

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value
contained in the Road User Cost Per Day times the Number of Days identified for the site will
be used to determine the successful Bidder.

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2 Page 9 of 32



Lane Rental Contracts
At the General tab,

e Select the appropriate Type in the Bid
Method field.

At the Sites tab create a Site 00 for the contract
time in the usual manner then create additional
Sites as described here.

e Rclick in the white space of the Sites
Tab

e Click Add to create a new record.

Enter information in the following fields:

e Site Number Use one site for each
instance where lane rental is to be
managed in SiteManager. Begin with
01.

e Liquidated Damages per Day Enter
the value identical to the Road User
Cost Per Day to be entered below.
This field will transfer to SiteManager
as a Disincentive amount.

e Typeof Days Choose CD in the drop
down menu from the TIMMETH code
table.

e Number of Days Enter the
Engineers estimated duration for the
lane rental time.

e Road User Cost Per Day Enter the
daily rate determined for the particular
Lane Rental activity.

e Maximum Days Enter the number of
days that will be indicated in the
Contract Specifications. (the
Maximum days).

e Description  Enter "Lane Rental

1 Tms-port PES

File Edit View Utilties “window Help
ix=Bas | #E | & | v | &

Genera\l Description Sites | Projects |Specia|Pruwsiuns| Sections I Iterns

Find Site Number: I

Contract Time

AD
02 Lane Rental Days AD

0n/oomn

|

-Site Details

Site Nurmber: [0

Type of Days: jAD
Mumber of Days: [235
Road User Cost Per Day:

Liguidated Damages per Day: |1
Maximum Days(A+B) |

{entering cost per day indicates (A+E) Site Time costy

o0/ooon. @
00/o0/00 - B

Caontract Tirme 3|

Specified Start Date
Specified Completion Date
Description

Comment,

Comment: |

Ready

Distat| | @ i~ @ @ | (@ Launchbar - Microsof..| @ CitixAccess Plaor.. | # C:AUsars\Fritz\Docu

File Edit View Utlities “Window Help
lixeas | R | & | vi | ¢

General | Description Sites | Projects |5pec\alevls|0ns| Sections I Iterms

Find Site Number: |

Contract Time
Lane Rental Days 2D

00/00/00

4

| Site Details

Site Number: [0z
Type of Days: jAD
Mumber of Days: |95
Road User Cost Per Day: |25000

a0i00/00 L)
Specified Completion Date 00/00:00 L]
Description: |Lane Rental Days =]
Camment: |Bridge Rental Days
Comment

Liguidated Damages per Day: |1
Maximurm Daysia+B): |55

(entering cost per day indicates (A+B) Site Time cost)

Specified Start Date

Ready

Costat| | @~ @ @ | [ Launchbar-Microsof..| & CiieAccess Platfor.. | # CAlsers\Fe\Docu. |

Days" from the SITEDES code table choices.

e Long Description 1
describe the particular location here.

If there is more than one instance of lane rental on the contract,

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2
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e Click ok to save the record to a data row.

During the analysis phase of the bidding, in conjunction with the bids on Pay Items, the value
contained in the Road User Cost Per Day times the Number of Days identified for the Site will
be used to determine the successful Bidder.

Construction Milestones

For general Construction Milestones either with or without Incentives and Disincentives, create a
Site 00 for the contract time in the usual manner. Then create additional Sites as described here.
Enter data on the Site Tab in the following manner.

e Site Number Use one site for
each instance where a milestone is  [Fie es vew Uiies windon Heb

to be managed in SiteManager. lEBOS  BE S | Vi i3
Begln Wlth Slte 20 General | Description Sites | Projects |Specwa\Provisions| Sectians | ltems |

i B Find Site Number: I
* LIqUIdated Damages per Day If Caontract Time AD 00/00/00

there is an incentive for the EET
Milestone, enter the value. This
field will transfer to SiteManager
as a Disincentive amount. The
Incentive value will be entered in
SiteManager. Otherwise enter
zZero.

e Typeof Days Choose CD in the

drop down menu from the o
-Site Details —
TIMMETH COde table' %LEE'\E’S:; f\g Liguidated Damages per Day: 250
e Number of Days  Enter the e O —-—

number of days associated with & pecifed StartDate: | —0303T0 %
the particular Milestone. Specified || & o -
Start Date and specified gggrr:::tt_lEarwcommetmnIncentwe
Completion Date may be used in

- - - - . Ready
ConjunCtlon Wlth thls duratlon- :'Slalllj @ (v @ @ J [@._,Lauﬂchbal-Mlcmsuf...l @Eltrlxi—\ccess Platfor... | j?EI.\Users\Fnlz\D\:u:u... Iﬂ

e Road User Cost Per day Leave this field blank, as the Site is not to be associated with
determining the successful bidder.

e Maximum Days Leave this field blank.
e Description  Enter "Construction Milestone™ from the SITEDES code table.

e Long Description1 Describe the particular milestone here. This field may contain up
to 60 characters.

e Click ok to save the record to a data row.
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The Projects Tab
The Projects tab of the proposal. The

Fle Edt Wiew Utlities Window Help

lower portion of this screen displaysa list |[1&8Bas | @ | & v | ¢
of projects that are not attached to any B0 ,
. General | Description | Sites Projects |SpecwaIFrawsmns| Sections | Iterns |F‘r’S:hedl
proposal, and so, are available to be Fid Project Control mber: |
assigned to the new proposal. This list

SR 363 WOODVILLE HWY
21088425201 NiA SR 363 WOODVILLE HWY 1l

will only contain projects that match the e i R 393 OODVLLE HAY L
Pay Item Year specified on the General
tab, and the Unit System of the
Controlling PCN.

The first project to be attached to a
proposal will govern the specification year e
and unit system for the proposal, so that all |&

2| a| > v

9280817204 e |SEMINOLE MOWING
1 1 1 1 IR MOWING & LITTER REM M
prOJeCts dlsplayed In the |0W€r SECtlon Of 19287217203 7R MOWING/LITTER REM Z2 1]
- . 18363715201 NIA DESIGMN CES TRAINING 1]
the window will conform to the Pay Item | 155015 A R 7o !
. . 18580925201 A SR 64 (MANATEE AWE) 1]
Year and unit system of the lead project. 18530335201 N SR 64 MANATEE AVE) i
196090152 A PROJECT CONYERTED FROM CES 1]
19611215201 7R Us301 1l
18688015201 MR SR TO 1]
18756223101 3481012P US 98 (BARTOW HIWY) 1]
1879881520 A ug 1]

Warning: In the Tabbed Folder mode,
controls exist to block a project from being attached to more than one proposal as
well as requiring all attached projects to be of a common Pay Item Year and unit
system. There is the ability to make these erroneous attachments via the drill
down method. DO NOT attach projects to proposals in the drill down mode of
PES, because these protections regarding Pay Item Year, Unit System, with
respect to previously attached projects are not available.

To add an additional project or projects to the proposal, scroll through the list in the lower part of
the window and highlight those to be added. Highlight multiple projects by holding down the
cTRL key while selecting the needed projects. After selecting the projects to add

e Click the single up arrow in the center of the window.

Note. Do not use the double up-arrow. It will attach every project in the list to
the proposal header.

The Special Provisions Tab
The Special Provisions tab features of Trnseport are not being used at this time.

The Sections Tab
At the Sections Tab.

e Click Generate Section and Line Numbers.
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The section numbers are set by Trnseport
and show in blue, indicating that they
cannot be changed. The section
descriptions are available to be changed if

e Trns-port PES

File Edit Wiew Utiities wWindow Help
|lixBas | FE | & vB | &

pri Proposal T3022

) A B _ General | Description I Sites | Projects |Specwa\Fruwsmns Sections | Items |FYEChEdL
desired. The description will default to the | masectonnumer
description of the lowest category number I
in the section (Structures —0100 or [ BGNALZATION
Roadway — 0200), and in some cases, will
need to be changed to reflect the total
project.
To add a section to the proposal,
e Rclick Add. Trnseport will add a
blank row to the list of sections.
e Enter data into the blank fields S
displayed in the detail area of the e
Sections tab page.
e Enter a proposal section number Gemerate Section & Line Mumbers
and a description.
e Click ok to add a proposal section, ADD MORE to add another section, or CANCEL to return
to the Proposal Sections list without adding a new section.
[ ]

Before leaving the tabbed folder window, save all changes to the database by selecting

Save from the file menu or choosing save when closing the window.

The Proposal Items Tab

The estimated prices may be
changed in the Worksheet. All

Ble Edt Vew (o Window Help
L=

& i3 +

ikBas

modified prices will be sent back

to the original project Item :
price(s), in order to maintain o
consistency of information within | ==
all parts of the proposal.
If quantities are to be changed,
they must be changed in the proper |
project =2
The FY Schedule Tab
The FY Schedule Tab is not in use. |«

/v4, Proposal T3022

ceneral | Desripion | Sees | Prowcts | SpecislProvsions | Secsons

Hems | | Amachements |

1021 MAINTENANCE OF TRAFFIC : 34006

2102 3 |COMMERCIAL MATL FOR DRIVEWY MAINTENANCE M3 2578 00

102 80 [WIORK ZONE SIGNE ED 21958 000

210274 1 |BARRICADETEMF)TYPS LILVP & DRUM) [ED 34452001

20277 HIGH INTENSITY FLASH Li (TEMF - T/F B) ED 16858 000

10278 |MARKER: PAVT REFLECTIVE (TEMPORARY) EA 363001

2104 4 MOWING Hi

Moa101 HAY OR STRAYW BALE A 057 004

210412 [TURBIDITY BARRIER STAKED! W]

108131 SILT FENCE STAKED (TYPE ) M1

20416 |ROCKBAGS Ea |

nin 1 CLEARTNG AND GRUBBING LE HA

2101 1 |ELEARING AND GRUBDING =T

2101 1 CLEARING AND GRUBBING R

3110 4 |PAVEMENT REMOVAL OF EXISTING CONCRETE M2 |

207 1 MAILBOY (FAY) (EINGLE) EA 17.00

1101 |EXCAVATION REGULAR ICE 1171.000 & 00000

022 EXCAVATION BORROW  (TRUCK MEASLIRE) M3 13264 00 541113

30 4 EXCAVATION SUBSOIL M3 165 000 0

2160 4 |STABILZATION TYPE B I(H 947001

2162 B FINISH B0 LAYER(GRASEING OFR) (1 50MM) L B7113.000

2385701 |BASE OPTIONAL  (BASE GROLIP M1) M2 1716.00

1285709 HASE OFTIONAL (BASE GROLP MS) L ATan 004 0o

2206 1 [TURNOLT CONSTRUCTION M2 75,001 16017

2300 119 BIT MATL(ASFH RUBBER BINDER INTERLAVER) |1 762718000 T 40000
.

Genorata Section and Line Humbars
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The Attachments Tab
The Attachments Tab is not in use.

Changing Proposals

To change information about an existing proposal,

e Rclick the proposal in the Proposals List window

e Click Tabbed Folder Change from the right mouse button menu.

Trnseport displays the Proposal tabbed folder window with all current information.

e Add or change information in any field except Contract ID.

When changes are complete,

e Click ok to save them, or CANCEL to return to the Proposal List window without saving.

Deleting Proposals

You can delete a proposal and its associated references, which include the following information:

e Related addendum information.

e List of projects associated with the proposal.

e Any association between the proposal and a bid letting.

e Project estimate information for all projects belonging to the proposal.

Do not delete proposals that still have data in Trnseport LAS (for example, bid tab or

planholder data). The Trnseport LAS data for those proposals will not be accessible.

To delete a proposal:

e Rclick the proposal(s) in the
Proposals List window.

e Click Delete.

Trnseport displays a Delete window. If
you choose Delete, you will delete the
association of a single proposal with the
projects associated with the proposal.
You will also delete the Proposal Header
records, sections, addenda, proposal sites,
and long description. Click CANCEL to
return to the Proposals List window
without deleting.

e Click ok to continue the delete

e Trns-port PES

Ele Edi Yiew Utiiies Window Help

lixBEas | & | v | t | 20 A9REES ¢

T3014
T3015
T3018
T3m7
T30m8
T30m8
T3020
T3021
T3022
T3023
T3024
T3025
T3028
T3027
T3028
T3029
T3030
T3031
T3032

T3033
T3034
T3035
T3036
T3037
T3038
T3038
T3040

T3041

SR 202 (PACE BLVD)
SR 85

SR 300 CAUSEWAY
ESCAMBIA CO

SR 77

SR8 (H10)

SR 51 (US 318)

SR 84 (-110)
5| AKULLA HAY
SR 368 23RD STREET
SR 20 SOUTH STREET
SR 263 CAPITAL CIR.
NAYY POINT PARK

SR 57 (US19)

SR 285

SR 30E

SR 30 (US 98)

SR 261 (US 319) CC

SR 30 (US 98)

SR 273

SR 201 ALGAMIZIMLE
FERRY RD

ROBERTS LANDING ROAD
SR 10 (US 90)

SR8 (H0)

SR 300 BECK AVEMUE

SR 65

SR 71 5TH STREET

Tabbed Folder Wiew

Letting Proposals

_—

Add
change
Delete...
Tabbed Eolder Add
Tabbed Eolder Change

Proposal
Proposal Prajsct List
Proposal Description
Addendum List
Proposal Items
Special Provisions Lisk
Site Locations Lisk
Seckion List

Run Process...

GG
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process. Trnseport displays a Delete Warning window.
e Click YEs in each of the warning windows to complete the delete process.

The authority to delete proposals is controlled by security access. If you are not able to delete a
proposal, see your District Application Manager.

Preparing to Advertise

District Let Contracts

When the proposal is complete and ready to transfer to the district contracts office, open the
Proposal Header and change the Access Control Group from CD## to CL##. At the same time
open the project headers of all associated projects and change their Control Groups to CL##.
The district contracts office will then initialize the proposal in LAS and prepare the
advertisement documents.

Central Office Let Contracts

When the proposal is complete and ready to transfer to the central office, open the Proposal
Header and change the Access Control Group from CD## to CC##. At the same time open the
project headers of all associated projects and change their Control Groups to CC##. After initial
processing in the State Estimates Office, the proposal and project Control Groups will be
changed to CT##. The Contracts Administration Office will then initialize the proposal in LAS
and prepare the advertisement documents.

Working with Addenda

After a contract (proposal) is advertised, all future changes to the proposal must be by
Addendum. An Addendum, may include adding Items, changing existing items, or deleting
items. The items may be in the same or different categories.

Remember that it is very important to accurately assign Project Line Numbers and Proposal Line
Numbers to each Addendum Item to be added. You will need copies of the proposal level
Preliminary Detailed Estimate, the Proposal Schedule, and the Generate Section and Line
Numbers (Inquiry) reports to do this accurately.

To add an addendum to a proposal
e Create an addendum header

e Specify the project, category, and line numbers (Project & Proposal) for each proposal
addendum Item.

Re-initialized the Proposal to transfer addendum information from Trnseport PES.
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Creating the Addendum Header Record
To create the addendum header:

e Click the affected proposal in the
Proposals List window

e Rclick Addendum List.

e Rclick Add.

The Addendum Header Detail window.

e Enter information for the following
fields:

Proposal Addendum No.
Date of Addendum

Description

When the addendum detail is complete,

e Click ok to save the record, ADD
MORE if adding another addendum
header, or CANCEL to return to the
Addenda list window without
adding an addendum.

frs; Trns-port PES

Fle Edt Yiew Udities Window Help

ipEas [ vi | ¢t 20496

= Proposals

T3014 SR 292 (PACE BLVD) CC
T3a015 SRBS [
T3016 SR 300 CAUSEWAY cc
TI0T ESCAMBIA CO CC
T3a018 SR7T cC
T3013 SR B (-10) cC
T3020 SRET (S 219) cC
T3021 SR 03 CC

KULLA HYYY i
T3023 SR D STREET change
Ta024 SR 20 SOUTH STREET elete..
T3025 SR 263 CAPITAL CIR. it —
T3026 NAVY POINT PARK Tabbed Folder Add
T3027 SR 57 (US 19) Tabbed Folder Change:
T3028 SR 285 Tabbed Folder ¥iew
T3028 SR 30E s
Ta030 3R 30 (U5 98) Proposal Praject List
T3031 SR 261 (US 319 CC iy o
T3032 SR 30 (45 98) Addepdum List
Ta033 BR 273 Pmpna\ Trems
T3034 SR 281 ALCANIZIMLK S Pl
T3038 FERRY RD Site Locetions List
T3036 ROBERTS LANDING ROAD et List
3037 SR10 (U5 80) Letting Proposals
T3038 SR8 (-10) il e
T3038 SR 390 BECK AVENUE Rn Process...

frs; Trns-port PES

Flle Edt Wew Lkities Window Help

ixBos | & | vi | t|2%

add

Eun Process...

prs; Trns-port PES

File Edit View Utiities Window Help
[lwxeas | » | ¢
fr= Add Addendum Proposal T3022

Page1 |

Proposal Addendurn Mo, (000001
Date af Addendum: 10i08/03
Description: Change\hem quantities
Generic Gode 1

oK Add More | Cancel
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Addendum Item Information

For the first change to a proposal, there will be no Addendum Item information.

To create the first one:
e Rclick the addendum header.
e Click Addendum Items.

e With the Item list blank, place the
cursor in the white space and

e Rclick Add.

Select from:

e New ltem
e Modify Item,
or

e Remove Item

Choose the appropriate action and proceed
as indicated below.

Adding New items

The Add Addendum Item Detail window
will open.

On this screen, in sequence:

e Click the Project No., from the list
box.

e Click the Category Number from
the list box.

e Enter a Project Item Line No. that
does not already exist on the
project. Examine the project
worksheet, the Preliminary
Detailed Estimate or Generate a
Section and Line Numbers
(inquiry) report and assign
appropriate line numbers.

frt; Trns-port PES

Fle Edt Yew Uities Window Help

ipBazs [ vi | & 2%

10/08/03 Change Item guantities
Add
Change

Delete...

Run Process...

Ble Ede Yeow Lblkies Window Hel
i=Bos B Vi &

pys Addendum ltems Proposal 13022 Addendum 000001

¢re Trns: port PES

Fil= Edic Wiew Utlities Window Help
[ixeas  * | ¢
fir Add Addendum ltem Proposal T3022 Addendum 000001

Page 1 |

Project Mo FREEEE R

Category No.: [0000
Project tam Line No.:

Type of Action: A (A C, D)

Iterm Number: ﬁ

Estimated Quantity: J0.000
Estimated Price: |0.00000

St Descr:

Supp. Desc. Required: [

Itern Alternate Code:
Specification Year: 00
Revised Price:
Source of Price: |E
Est. Price Lock: []

Generic Code 1:

Combine with Like ltems: [
Non-Participating Fund Code 3

Non-Bid ltern: []

Pre-Established Price: []

Proposal Line Number.

oK AddMore |  Cancel
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e Enter an Item Number or select from the list box.

e Enter the Quantity for the added Item.

e Assign a Proposal Line Number that does not

already exist on the proposal, unless it is to — =

combine with existing Project Line Numbers.
Recall that the Proposal Line Numbers are
initially assigned in steps of five. Examine a copy
of the Proposal Schedule and determine where the
Item should be displayed, and assign an

appropriate number.
e Click ok.
Or

Generate Preliminary Detail Estimate ;|
Generate Proposal Mumber Change Report

Generate Proposal Schedule
(Generate Section and Line Numbers (nguing J

Generate Section and Line Mumbers (Update)
List Contract Proposals

List Proposal Addendurms

List Proposal Pravisions ﬂ

OK I Cancell Help |

e ADD MORE if other items are to be added.

Modify Existing Items.

If the addendum is to modify one or more

Items,

e Click Add > Modify Item.

Proceed sequentially to:

e Click the Project Number from the

list box.

e Click the Category Number.

e Click the Project Line Number
from the list box (the Pay Item and
Proposal Line Numbers are now

identified).

e Enter the corrected quantity.

e Click ok or AbD MORE if other

Item quantities are to change.

¢re Trns: port PES

Fil= Edic Wiew Utlities Window Help
[i=Bas | B | &
fir Add Addendum ltem Proposal T3022 Addendum 000001

Page 1 |

Project Mo, [21988415201

Category No.: [1200

Projectiterm Ling No.: 0030 hd

Type of Action: (A, C, 0}

ttem Number: 2102 74 1 4| BARRICADE(TEMP)(TYPS |ILVP & DRUM)
Estimated Quantity: [542562.000 ED
Estimated Price: 0.30000 Supp. Desc. Reguired: [
=0 Descr: [
[
Item Altemate Code:
Specification Year: 00
Non-Bid item: []

Pre-Established Price: []
Proposal Line Number: [0025
Generic Code 1:

OK Add More Cancel
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Deleting items

If an Item is to be deleted, T T
[ixeas | & | ¢
e Click Add > Remove Item
' Page 1 |
B . ProjectMo.: pToseaisam
Then, in sequence select: ey [T
Project ltem Line No. o0 =]
. . Type of Action' D (A, C, D)
e Project Number from the list box et B0 LR oL
Estimated Price: 8500000 Supp. Desc. Required: []
* Category Number from the IiSt box S:::;::;T;: Combine with Like lterms: (<]
Specification Year 00 Mon-Patticipating Fund Code:
e Project Item Line Number from S ofic: 00 S e
. Est. Price Lock: D Fraposal Line Mumber: 0085
the ||St bOX. Genetic Code 1
The deletion is now fully detailed, as all
other fields on the window are blue.
Addendum items WILL NOT show in the
Items Tab in the Proposal Folder. The
Addendum items WILL show on the

Proposal Schedule Report.

Correcting Addendum Item Information

If the addendum has been completed and there are errors, it may be re-opened. To do this,
e Click the proposal involved from the Proposal List window.
e Rclick Addendum List.

To change the header information,
e Rclick Change, and make the necessary corrections.

If it is necessary to add change or delete Items,

e Click Addendum Items.

Trnseport now displays the Addendum v Troe ort PES
. . Elo Edet Wow Lkltins Windw Hep
Items List window. 1v@as | ® | Ve | ]2

ey Rulddenglum Mems Proposal T3027 Addewdom 000001

e Click the Item of interest.

21968115001 UEN]

e Rclick Change.
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Several fields are now in blue, and cannot
be changed.

e Change other information as
necessary.

e Click ok to save the changes.
Or

e Click cANCEL to return to the
Addendum Items List window
without saving.

Deleting an Addendum

If an addendum has been entered in error,
it may be deleted,

e Rclick the addendum in the
Addendum List window.

e Click Delete.

Trnseport displays Delete Warning
windows.

e Click YEs in each window to
complete the delete process.

Maintaining Addendum Item Information

frs; Trns-port PES

File Edit Wew Utiitiss Window Help
[1rBaSE & | &
rri; Addendum em 0030 Proposal T3022 Addendum 000001

Page 1 |

Project No: 21988415201
Categary Mo 0200
Project ltern Line Mo 0030
Type of Action: C (A C O}
ltern Mumnber: [2102 74 1 | BARRICADE(TEMP)(TYPS LI VP & DRUM]
Estimated Quantity: [38452 000 ED
Estimated Price: [0.30000
Supplemental Descr:

ltern Alternate Code:

Specification Year: 00

Supp. Desc. Required: [

Mon-Bid ltem: []
Pre-Established Price: []

Proposal Line Mumber: [0025
Genetic Code 1:

oK Cancel

......

i Trns-port PES
File Edit ‘iew Utiities ‘Window Help

[ixBas | B | ve | & 23

Addendum

Addendum Items

Trnseport treats each addendum Item record as a transaction to apply to the original project.

Because Trnseport includes addendum items in Trnseport LAS reports, you must specify the
project, category, Item number, and Item alternate code (if any) for each proposal addendum
Item. Also specify the proposal section number and proposal line Item number.

To maintain addendum Item information, select the addendum of interest and select Addendum
Items from the right mouse button menu. Trnseport displays the Addendum Items List window.

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2

Page 20 of 32



Listing Proposal Addenda

To produce a printed copy listing proposal addendum information,

Click the proposal or proposals to list addenda from the Proposals List window. (Select
more than one proposal by holding down the cTrRL key while selecting proposals.)

Click File > Run Process from the Menu Bar. This will display the Processes window.

Click List Proposal Addendum from the report list.

Click ok to run the process.

Click suBmIT to run the process, PARAMETERS to change process submission parameters,
Or

Click canceEL to return to the Proposals List window without running a process. See
Running Processes and printing Reports for more information.

Rejecting Bids

When the situation arises that bids are to be rejected and a contract is to be re-advertised the
process will begin in the Contracts Office. Certain fields in LAS will be re-set to indicate that
the bids are being rejected and the contract re-advertised.

The OId Proposal Header

Contracts Office

Change the Access Control Groups of the proposal and all associated projects from
CL## to CD##, or from CT## to CD##, as appropriate, so that the district estimator who
created the Proposal Header will be able to update the projects and create a new Proposal
Header for the new advertisement.

District Estimator

From the Proposals List window, Rclick the proposal to be modified.

Click Tabbed Folder Change.

Click the Projects tab

Click the single or double down arrow to remove the project(s) from the proposal.

After removing the project(s), close the proposal and save the file. This process makes
the project(s) available to be attached to a new Proposal Header.

Change the Access Control Groups of the proposal from CD## to CL##, or to CT##, as
appropriate. The old proposal header will then be available in the appropriate contracts
administration office for history purposes.

When the Save confirmation message opens, click YEs.
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The Projects

Make any changes to the projects(s) that may be necessary. Particularly, if there were any
addenda to the original proposal, enter all changes into the projects before re-advertising the
proposal.

The New Proposal Header

e From the Proposals List window, select Tabbed Folder Add from the right mouse button
menu.

e In many cases, using the Copy Special feature for projects, categories, and proposal can
save steps. In this case, however, it is important to NOT use the Copy Special feature.
If the original proposal had addenda attached to it, the number of the last addendum
issued, would be recreated on page 2 of the new Proposal General tab.

e When the new Proposal general tab window opens:

Go to the Cntl PCN: field, and from the list box select the lead project.
From the Menu Bar, choose Edit > Import Controlling PCN data.
Enter the new Proposal Identifier (“E” Number).

Click the page 2 radio button,

Enter the Old Proposal Number into the Prev. Let As ContID field.

0O O O O o o

At the Projects Tab, Select any additional project or projects to be connected to the
new Proposal Header. Click the single up arrow.

o Click the Items tab. A warning window will open indicating that changes have been
made to the proposal Click ok.

0 Click the Generate Section and Line Numbers button at the bottom of the window.
0 The reconstructed proposal Item information will appear in the Items tab.

e Save and close the tabbed folder by clicking on the X" for the tabbed folder window.

Running Processes and Printing Reports
Project Level Reports

One of the most useful reports is the Preliminary Detail Estimate. It may be run at both project
and proposal levels. Its value is that it contains all of the structural detail of the project or
proposal with line numbers, sections, categories, items, and quantities. Trnseport also
summarizes the estimate with subtotals in several formats.
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To run project level reports, begin at the
Project List window.

E Trns-port PES

File Edit “iew Utlities 'window Help
im@als & vl t] clemmels|

e Rclick the project(s) for which you

1111

want to generate reports in the

11111

Karen's project- pave road

111111111 4312007 BRIDGE #780072  RE
PFOJGCtS List window. 18016813201 18016813201 STATEWIDE BRIDGE
19074915201w 18074815201 NORTHERM TURMNPIKE G
. 18363715201 18363715201 STATEWIDE
° C||Ck Run Process. 19?92515201 19782515201 FROMBIG 5

2147561 ?21 2

21019815201

ive - 1295

21475617212 Add
21475617215 21475617215 Change erations Wark Oro
21788015201 * Delete... NORTH BAY)
. . . . 21860815201 21860815201 T abbed Folder dxdd a0 BAYOU
This will display a list of processes that 21960815201K v —— £ a0)
. . 2186081520 1we 21860815201 T abbed Folder isws a0 BAYOU
are available at the project level. 21862515201 21862515201 = 508)
21867415201 21867416201 Project g 20
21876515201 1991043P Categon List 5319
21980915201 21980915201 PES Workshest O0DVILLE HiAYY
22079215201 4602012P Breakdown List
22087515202 22087515202 County Information List MAIDE  PUSHE
22087615201 22087615201 Pay Adjustment Indices List— Iryy|DE
22007615204 22087615204 MWIDE
22007615208 22087625208 CTION IMP. SR, 1
22088525201 22086525201 D THERMOPLASTICS F

Here is a sample list. Your security authority may not
permit you to run all of the processes available in the
system.

e Click Generate Preliminary Detail Estimate.

e Click ok.

r'rr Prucesses

|Generate Contract Project Directory

Generate Master Payitern List

List Project Estimates

List Projects

Project Proposal Crosswalk
Renumber F'raject Estlmate lterms

‘Generate Preliminary Detail Estimate
Generate Proposal Mumber Change Repaort

|

Trnseport displays the Detail Cost Estimate Parameters ok | cancel | nep |
window.
- ) ) Page 1 |PageZ | Page 3|
The parameter selection window, which has three
pages. Page 1 shows a default selection to
renumber the Item line numbers. Renumber Estimates:
e If you do not want to renumber them, turn
off the "x".
e Click the Page 2 button.
Submit I Parameters Cancel |
Enter the level of summarization on Page 2. This
option determines whether to run the Detail Page 1 Page2 |Pages|
Estimate for a project or proposal. The
Department is not using prime projects. O PRIME
e Click Project level of summarization,
e Click the Page 3 button.
Submit I Ealamelelsl Cancel |
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Page 3 shows the Parameters window, which
allows selection of particular reports.

Click the boxes of the desired.

e Click suBmiIT to run the process,

PARAMETERS t0 change process
submission parameters, or CANCEL to
return to the Projects List window without
running a process.

Detail Cost Estimate Parameters [ <]

Page 1 | Page? Page3 |

Select Repoarts:
Detail Estimate Cover Page: [
Cost Surmmary: [X
Cost Estimate: [}
Funding Surmmary: [X
Funding Surnmary by Unit: [
Funding Surmmary by Fund: 5

Select Data Sources: Default Database is PES

Letting and Award System (LAS): [~
Construction Administration Systerm (CAS): [~

Submit IEalameletsl Cancel |

Proposal Level reports

To generate proposal schedules,

File  Edit Wiew

m Trns-poit PES

Utilities  Window Help

e Click the proposal in the Proposals | asl@lcls] & wle] o 2lw]xs]z= )6 e|w
List window
' [ComtractiD Description  Twme

11111111111 Test proposal for LS, fereral aid #, altemnates cc

H 190748-1-52-01 Guardrail Upgrade & Resurfacing cc

e Rclick Run Process. je ez puaor

2000 US 1 New Road Construction co
214 112 Duval County Prifnass o3
21862615201 WILL & RESURFAC,  2dd co
21876515201 SR 377 (U5 319 | Change ME
21980815201 R 363 WOODVILL__ Delete L
22087615204 DISTRICT WIDE T abbed Folder dd
22087625208 SR.1DMNIME MILE | Tabhed Folder Changs DC
22088525201 THERMOPLASTIC | Tabbed Folder View cC
22458417201 RPM'S MG
224584PROP Pah'S PROPOGAL  Fioposal
238336-1-52-01 Easthound acceler,  Froposal Project List cc
251838-1-52-01 SR-B36 atSR-921  Froposal Desciption 3
909 SR.10(NIME MILE  Addendum List
999059016 Thermoplastic & R Piopasal ltems sa Countie MG
ATEST TESTFROPOZALT  2Pecial Provisions List BLEM MG
BE117 MOA - City of Atianti  Site Locatians List MMOA
BB117Y2 MOA - Gity of Alanti  S#ction List MMOA
BE117Y3 MOA - Gity of Alanti  Letting Propasals MMOA
BTEST TEST PROPOSAL " MC
F2987Y1 Intermadiate Mashi M

This will show the list of processes that are available

the proposal level. Here is a sample list of processes that
are available. Your security authority may not permit
you to run all of the processes available in the system.

e Click Generate Proposal Schedule from the
Processes window.
e Click ok.

These are the report options. Because of the

Page

Proposal Price Schedule Dptions

at

s Processes

Generate Proposal Mumber Change Repart
(Generate Proposal Schedule

Generate Section and Line Mumbers {nguing
Generate Section and Line Mumbers (Update)
List Contract Propasals

List Proposal Addendums

List Proposal Pravisions

Proposal Letting Crosswalk

0K I Cancel |

Help |

security of estimates, estimators will need to
run this process, including the Engineer’s
estimate, if desired.

Click the options desired.

il
Froposal Cover Sheet: X
Proposal Schedule of Prices: X
Froposal Estimate: r
Special Provisions Listing: [
Special Provisions Text [~
DEE Interest Report: B
Generate Pass File to EBS: [T

EBS Pass File Mame: [USERID. TXT

e Click sumiT

Submit IEalamelelsl Cancel |

Trnseport PES Proposal Development Guide (Production) - Release 5.9a Revision 2

Page 24 of 32



Two information windows will open to confirm that the process has been submitted and when it

has completed running.

e Acknowledge both when they open.

Process Status

To see the results of this process,

e From the Menu Bar, Click File >
Process Status.

This screen lists all of the processes recently
run.

e Click the report just run (check the date
and time columns),

e DbIClick the blue band.

These are the reports available from this
process.

e DblClick the report outputl.txt and
review the report on screen.

Electronic Proposals and Addenda

ETms port PES
Edit View Utilities W’lndow Help

Open Bid Letting List Yllal _I pl@'|ﬁ|§|3"|hﬁ le@”

Open Propozal List

Open Prime Project List
proposal for LS, feraral aid #, alternates

DOpen Project List
Close
Reference Tables » |rdrail Upgrade & Resurfacing
- |oject

Mew Road Construction CC

Bun Prm:ass

il al County Primary

Pint Setuﬂ [ & RESURFACE cC

Jmpot y BT7 U5 319) MG

Eird 63 WODDVILLE HIWY L

-~ RICTWIDE

Exit 10{MINE MILE RD ) D
22088424201 THERMOPLASTIC cc
22458417201 RPM'S i
224524PROP PAM'S PROFOSAL
238335-1-52-01 Easthound acceleration lane on US 441 c

CRLAAG b OO AT LIECT

T Tns-port PES
Elle Edit Wiew Utiities ‘window Help

isleolz = vl | &
Find Process Name:

06:38 prm |08:38 pm

FESMFRPA Cnmpleted Successquy 08r18/89 0510 pm (0510 pm
FRAREMA Completed Successiully 08r16/89 10:34am  [10:34 am
PRARENB Completed Successfully 09/16/99 1012am  |10:12 am
LASINITC Completed Successfully 09713539 0216 pm |02:15 pm
LASINITD Completed Successiully 0913599 0228 pm  |02:28 pm
LASINITE Completed Successiully 0913599 11:20am |11:20 am
LASGETAA Completed Successfully 0951 3/99 10:52am  [10:52 am

ETms-pull PES
File Edt Wiew Utles Window Help

1k Ba= B L 2| & w

output2.bd

984 09519799 18:38:46

All central Office and many District Office let contracts will be produced and distributed on
electronic media. When the proposal processing has reached the stage of transferring control of
the proposal to the Contracts Administration Office, the electronic proposal may be prepared.
All of the processes of creating electronic proposals and addenda are performed in the Contracts
Administration offices (Central Office and District Offices). The Proposal will have been
attached to a Letting Header and the proposal initialized into LAS.
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Creating the Proposal

Begin in the Proposals List window as

seen here.

e Click the Proposals(s) to be
prepared.

e Rclick Run Process.

e Click Generate Proposal Schedule.

e Trns-port PES

File Edit Yiew Utiities ‘Window Help

izxEas | B | v | t |20 492 EBE |

T4001
T4002
T4003
T4004
T4005
T4006
T4007
T4008
T4008
T4010
T4011
T4012
T4013
T4014
T4015
T4016
T4017
T4018
T4018

The Proposal Price Schedule Options window
will open. It is the same window used to create

a paper proposal schedule.

e Check the box labeled Generate Pass

File to EBS.

e Inthe EBS Pass File Name field leave

the entry Userld.txt.
e Click Submit.

Wait until the Status Monitor reports that the process has

-1 041-95INTERG
SR 5 (OLIVE AVE)
SR &0 (SOUTHERN BLVD)

SR 60

SR 817 (UNIVERSITY DR) AND SR 824 (FE
SR 808 (GLADES RD)

SR 845 (POWERLINE RD)

SR 80 (SOUTHERN BLVD)

SR 808 (MILITARY TRAIL)

SR 704 (ROYAL PALM WAY)

SR 16 (DAKLAND PARK BLYD)
SR 80 (SOUTHERN BLVD)
SR5US1)

SR A (US 1)

ANDREWS AVE

SREWUS1)

SR 0 (-85)

SR 818 (GRIFFIN RD)

SR 708 (BLUE HERON BLVD)
SR 823 (FLAMINGO RD}

o PrOCEsSSes

Add
Change
Delete...

Tabbed Folder Add
Tabbed Folder Change
Tabbed Folder Yiew

Proposal

Proposal Project Lisk
Proposal Description
Addendum List
Proposal Items
Special Provisions List
Sike Locations List
Section List

Letting Proposals

Generate Preliminary Detail Estimate
Generate Proposal Mumber Change Repart
‘Generate Proposal Schedule

Generate Section and Line Mumbers {nguing
Generate Section and Line Mumbers (Update)
List Contract Propasals

List Proposal Addendums

List Proposal Pravisions

oK I Cancel |

Help |

& Proposal Price Schedule Options

Page 1 |

Proposal Cover Sheet [
Proposal Schedule of tems: [~
Propasal Estimate: [

Special Provisions Listing: [~
Special Provisions Text [
Quantity Sheet Summary; [~
DBE Interest Report [~
Generate Pass File to EBS: [

EBS Pass File Mame: juserid td

Submit IEalamelersl Cancel |

DPS Status Monitor

completed. An electronic proposal flat file is now located .

\ ll) Profile PESGPPSA For process PESGPPS has completed
=

on a Trnseport server.

e Click ok to close the window.

X|
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Download Files

frs; Trns-port PES

File Edit View | Utiities ‘Window Help

H 1k £ Options...

change Password...

Generate Suppork Request. .

From the Menu Bar, T2048

Download the file(s) from the Trnseport system
and move them to a new location.

[t c@A=mEMB S

Deefine Custom Processes

T2049 Daownload File RTF Template gg
. e R T2051 Upload File 3 Process Configuration File oo

e Click Utilities > Download File > Process | +us: Copy Bid Hitory Fie P ie
1/0 File. oo e S o
T2056 SRYA o
e DbIClick the directory gebsfnamdir. Al et DIt [ o |
£ gbidhistdir B ﬂl

3 gbidtabdir

£ gedsstrcdir J Help |

£ qebsf o
£ qexportdir
3 qfundseqdir

;I " Exclusive

In the File Name window,

. R File Name: Directories: 0K
e DbIClick your userid.txt. Jkn87 1w faebstnamdir
kn846jb.ba ] [c2 qbidnistdir = w
kn846nj.b<t 1 qbidtabdir

kn971rh.bxt

pc232pe.ba
pc23Zsloxt

£ qedsstrxdir

J Help

= nebsfnamdir

3 qexportdir
1 gqfundseqdir

= I~ Exclusive

The Save 1/0 File window will open for you to

choose file location and name. Click the Navigate

. . . ave i My Computer
Up || icon until you reach this screen: - RITET

o
x

rleme B

204 on'Client’ {v:)

53‘;‘; Floppy (A}
taee Local Disk ()
|4.CD Drive (D1}
_'ﬁProd on 'dokveafp001lappdatatColkna 7 L' {01
_'ﬁExpedite_Prod on 'Datvcafp001iapps' (01

=0 Fxpedite_Prod on ‘Dotvcofp00l’ (R

< |

For Central Office processing,

e Choose the folder labeled
CO_Expedite_Sys on 'Dotvcofp001’ (R:).

2l
L CIle Open File name:  [knd7 1w Open I
For District processing, the file structure is built in | S#=tes JaiFiesr) B =]

a similar manner, but the CO is be replaced by your district number.

Caution: These next steps will copy the newest
version of userid.txt and overwrite
previous versions. Be sure that

Save jn: I_ﬁ CO_E =pedite_Frod on 'Dotvcofpﬂm'j L] EF Efl~

C)Bid Ttems 14Dec001,001 22Feb002.EBS
previous downloads of userid.txt have | |59 usiees i 14000t 002 51 2zrebons.ees
C)EBLIE 14Dec001 EBS 22Feb004.EB5

been processed by the EXpedlte Gen ) kevbackupberc_bondcheck 14DecDDZ.DDl

|| 22Fetons.E63

. . L lettings = 14Deconz E65 &= 2zFetians.E6S
module, and the EBS files placed n DSMagyDDl.EBS =) 22Febiot £es =l 253an001. €85
their proper folders. N |

This screen will now open to accept the new file. Fiename:  [kn371we

Save as type: IAII Filez [*.%)

e Click Save.
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. . . . . . File already exists X
Next, you will receive this warning/confirmation message / [

o CIle Yes to overwrite the fl Ie. & D you wish ko overwrike this file?

] w |

The electronic proposal(s) is now complete and available for the
Contracts Administration Office in either the Central Office or a District Office to prepare discs
for delivery to prospective bidders using the Expedite program and its modules. The Gen
module of Expedite will convert the userid.txt file into another format useable by bidders.

Electronic Addenda

Once the job has been advertised and proposals distributed to prospective bidders, all changes to
the proposal will be made by addendum.

When the addundum has been processed, run the Generate Propsal Schedule again.

e Check Prqposal Cover Sheet to see a x|
paper version. Page 1 |
Proposal Cover Sheet W
e Check Proposal Schedule of Items to Prapasal Sehaduls of e |7
1ot1 ecial Provisions Listing: [~
See a paper IIStIng' SpSpel\Pa\Pro\nsmrl;s'tre)i m
Quantity Sheet Summary; [
e Check the box labeled Generate Pass e
File to EBS. EBS Pass File Name: juseridbd
° Click Submit' Submit I Ealamelersl Cancel |

The remainder of the steps are the same as the creation of the original file above. After the Gen
module in Expedite transforms the file for bidder use, an additional file for each addendum will
be included.

icrosoft Internet Exploren

svorites  Tools  Help

Iﬂ |EL| ;\J 7 ) Search ‘:\7 Favarites  {0£) = ﬂ @ i.\‘
Web Rep 0 rtS 3.dat.state. fl.us/LoginfDefault. asp v ﬂ Go |:Llinks : Mortor)
In addition to standard reports within PES v L ORIDA DEPARTMENT OF
several reports have been created that are ”’% TRANSPORTATION Help
accessible from the FDOT Intranet. At the
U RL By logging on to & FDOT system, you acknowledge your responsibility to comply with all laws,

rules, directives, policies, and procedures related to the use and security of information technology
resources. Unauthorized use is strictly prohibited. You are hereby on notice that you should have no

https ://WWW\?J.dOt.state.fI . us/Trnspo rtRe zztpeeﬂcttlz:lw;nssgfér;\;atcuy':alint;aly;n:ruEIT:CE sczfj:?ar::m infarmation technology resources as all data is
ports/default.asp

Please Do Not Bookmark or Add this Page to your Favorites!

you will see this Log In screen. User ID:
Password:
e Enter your user ID and Password

O Change Password ?
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You will see a list of Designer and Pre
Letting Reports. Depending on your
access security, you may have a different

list.

Proposal Summary of Pay Iltems

To run the Proposal Summary of Pay

ltems

Click Proposal Summary of Pay
Items

Enter the Proposal ID in the Input
Data field.

Click Submit.

Click Refresh after the report has
time to run.

Click View to see the report.

The report is seen at right.

Other report in this series are generated in
a similar manner.

Trns*Port Web Applications and Reports Menu

s

]
el
L=l
o
L=l
o
el
L=l
el

+ Designers

Designer Interface

Project Edit Report

Master Pay ltern List

Proposal Summary Of Pay ferms

Project Summary Of Pay ltems

Project Item List

Pay ltern Average Unit Cost (drills down to pay item histarg)
ltem Awerage Unit Cost

Unit Of Weasure Conversions

Crosswalk Report

» Estimators

< Pre-letting Reports

equest Form - Microsoft Internet Explorer

Pay Itern History see Pay ltem Average Unit Cost)
Pay ltern Average Unit Cost (drills down to pay item
histony)

Histatical Bid ferm Summary

ltem Average Unit Cost

Master Payitern List

Project Edit Report
Payitern Search On Future Jobs

EHVWA District Cost Estirnate Surmmar
Proposal Summary OFf Pay lterns

Unit Of beasure Conversions
Crogswalk Report

vorites Tools  Help

* Faworites 6‘:

.dot.state fl.usftrnsportZfreports/ TRMS_RTF_Request/TRMS_RTF_Request.asp

VEGD

i Links | Mart]

yFiorids.com

TRNS*PORT WEB REPORTS

Main Menu

TRNS"PORT REPORT REQUEST MENU
Please select the report process to run and select the data for the process. After selection is made,
click the SUBMIT button. Your process will be submitted and shown in the Submitted Processes

below for report view selecting

Select Process:

Enter Input Data:
Please use the Proposal ID for the input data

Proposal Sumemary of Pay ltems v

Process Status for KN971WC

KNI71WC PPROPOTY TEI47 Complete v

—

FDOT

Office of ),
Information Systams

FLORIDA DEPARTMENT OF TRANSPORTATION

** The image in the header of this page will apen a new brovsar window ™

2 fip://ftp.dot.state. fl us/outgoing/ces/40883415201. TXT - Microsoft Internet Explorer

Flle Edt Vew Favorkes Ipols Help

H B ] O

Aderess | (€] fep:/ffip.dot state.fl.usjoutgoing/ces 40883415201, THT

= =

Favorites  464) -

N=Iwl R ¥

v By ks ing

FLORIDA DEPARTHENT OF TRANSFORTATICH
PROPOSAL SUMMARY OF PAY ITENS

FFROPOTY 04/16/04
FROFOSAL @ T6047 LERD FINFROJ : 40883415201  COUNTY : MIAMI-DADE
FINFROJ(S): 24883725201 COUNTY/SECTION: 87281000 R
25023425201 87281000
25023445201
25023455601
40832015201
40883415201 87251000
|
| 0001 SUMMARY OF STRUCTURES PAY ITENS
£
P |ALT | ITEN | ITEH |UN | 24933725201
c 1 NUMEER | DESCRIPTION |IT |BR § 874540
-1 I -1
| |o101- 1- | HOEILIZATION LS | 0.000)
| |o101- 1- | HOEILIZATION LS | 1.000
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING LS | 0.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING LS | 0.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING LS | 0.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING LS | 0.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING |LS | 0.000)
T | |0400- 85— | COFFERDAN |EL | z.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING |LS | 0.000)
| |oti0-  3- | STRUCTURE REMOVAL OF EXISTING |LS | 0.000)
T | COFFERDAN 0.000)

|0400- 95—
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Appendix A Control Group

The assignment of Access Control Groups is one of the principal tools available to the
Department to control access to project data. Through the plan outlined here, a hierarchy can be
established where data may be compartmentalized to restrict access to a set of people who need
visibility of a particular project and to deny visibility to those who don’t.

The use of Control Groups satisfies two concerns. The first is to reduce the volume of
information that will appear on Project List screens, and second to secure information during the
bidding and award process. The use of Control Groups allows the visibility of projects to be
moved from one person to another. An example would be a project in District 2 that might have
a Control Group of CD02PMA. With this Control Group assigned to the project, the District
Estimator(s), having a personal Access Control Group of CD02*, would always have visibility of
the project. Similarly, any person having an Access Control Group that is less restrictive would
also be able to see the project on his or her project list screen. For example, a user with an
Access Control Group of C* would have access to every project in the Production organization
statewide.

For the management of projects for Central Office letting, the sequence of Control Groups
assigned to the Projects and the Proposal Header when it is created, would be as follows:

e CDO02PMA: When under the control of a District Project Manager.
e CDO02: When control of the project shifts from the Project Manager to the District Estimator.

e (CCO02: When the District Estimator transfers the proposal to the Central Office for letting. A
further refinement here will be decisions in the Central Office Estimates Office about
compartmentalizing within itself. For example, a particular estimator may use CC02TW
(initials) to assign the access to another estimator, or CC02A to have proposals shared by two
or more Estimators as a group within the overall estimates office.

e CTO02: When the proposal is ready for processing by the Central Contracts Office. Itis
necessary that the proposal Control Group remain unchanged while the project is in LAS and
the Contracts Office in order to ensure that the Engineer’s estimate is always under the
control of only the estimator.

The following table illustrates how visibility of projects to a community (Maintenance or
Production) for oversight is granted, and then to a smaller group of project or maintenance staff
for the control and management of project detail.

PES LAS
District Contracts Manager PLHH* FLHH*
District Contracts Assistant A PLHA#H#A* PLHREA*
District Contracts Assistant B L##B* ?2L##B*
District Estimator CD##* CD##*
Assistant District Estimator CD##A* CD##A*
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PES LAS

District Production Director CD##PM*  None
District Production Project Manager A CD##PMA* None
District Production Project Manager B CD##PMB* None
District Project designed by Consultant Firm CD##T###  None
District Maintenance Engineer MD##* None
Assistant District Maintenance Engineer A MD##A* None
District Maintenance Contract Estimator MD##* MD##*
Assistant District Maintenance Contract Estimator MD##A* MD##A*
District Work Program Manager 7D#H#* None
Central Maintenance Manager M* None

Control Group Structure:
Character position 1: M = Maintenance Project
C = Construction Project

Other characters may be assigned if desired to segment project
development to other specialty areas.

Character position 2: D = District Office processing
C = Central Office processing
T = Central Contracts Office
L = District Contracts Office

Character positions 3 & 4:  District Number

Character position 5: The letters T, U, V, W, X, Y, and Z are reserved for Central Office
and statewide use. When a consultant firm is the designer of a
project, the last four characters of the control group will identify
the consultant firm. The letters T, U, V, W, X, and Y identify
consultant firms.

Character positions 6/7/8:  Organizational or subordinate breakout where desired. For
consultant firms, these three characters, in conjunction with a letter
in character position 5, identify the firm.

A project created and managed in the Central Office could be assigned an office code.
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The Control Group feature is a very important tool, but it has limitations:

e Itis not a code table and, therefore, will require a thorough understanding of the structure by
Application Managers and Security Coordinators.

e Control Group is not available to Letting Headers.

e When transferring a project or proposal to another user, care must be taken to ensure that all
letters in the new Control Group are capitalized, and that a valid Control Group has been
used. If these precautions are not taken, a project or proposal will be removed from the
project or proposal list screen of the previous user and will be available to no one. Under this
circumstance, a user with high-level authority such as a Security Coordinator or Application
Manager will have to find the errant project or proposal and assign a valid Control Group to
it.

Control Group Life Cycle

A Control Group assigned to a project/proposal might evolve in the following manner:

Construction Project

Receive Production Project from FM CD##

District reassigns project internally CD##A (or other subset)
Or

District reassigns to consultant firm CD##T365 (or other subset)

Pass file to District Estimator CD##

Create Proposal Header CD##

Pass to District Contracts office CL##

Contracts Office processing CL## (or subset if desired)

Pass to Distr Estimator for Bid Analysis CD##

Return record to Contracts office CL##

Complete award and execute phases CL##

Or for Central Office let contracts

Pass file to District Estimator CD##
Create Proposal Header & Price Job CD##
Pass to Central Estimator CCH##
Pass to Central Contracts Office CT##
Pass to Central Estimator for Bid Analysis CC##
Return record to Contracts office CT##
Complete award and execute phases CT##
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